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Dear Customer;
I would like to thank you for purchasing FastARTIST™ graphic design and print
controller program for the Fast T-Jet™ direct-to-garment printer. FastARTIST™ is an
easy-to-use program that is very similar to Corel Draw, and Adobe Illustrator. It also has
many features commonly found in Adobe Photoshop. In fact if you know these programs
you should have no problem using FastARTIST™.

Not only is this an excellent design program, it has key features for printing to your T-Jet
printer including support for printing white ink on dark garments.

Please take time to read the important points of this manual and watch the accompanying
DVD tutorials. You will be able to replace most of what you do in Corel, Illustrator or
Photoshop with FastARTIST™.

If you are comfortable with the other programs you can easily create artwork in them and
import them into FastARTIST™ for output to your Fast T-Jet™.

Don’t be intimidated by the size of this manual! Like all computer graphic software, there 
are lots of buttons and features and at some time you might need a reference for what
everything does. This manual has been designed so the first few chapters may be ALL
that you need! The back chapters go into detail about many features that you may or
may not use. Read Chapters 1 –5 and start doing prints.

Have fun!

Best Regards,

Scott Fresener
CEO
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CHAPTER 1
GETTING STARTED AND INSTALLATION

WELCOME TO FASTARTIST!
INCLUDED WITH FASTARTIST

Your version of FastARTIST includes this manual, CD/DVDs with the program including clipart and fonts, a
White Ink training DVD and a general training CD. This version of FastARTIST will work with a Fast T-Jet
Standard and a Fast T-Jet Jumbo. You also should have received a dongle hardware protection key. DO NOT
LOSE OR DAMAGE THE DONGLE. Think of the dongle as hardware. Treat it as your computer.

SYSTEM RESOURCES AND REQUIREMENTS
The speed and configuration of the PC can have a huge effect on the performance of the FastARTIST program.
With that in mind we make the following recommendations.

A minimum recommendation would be 2 Ghz PC with Min 512mb Ram and a hard disk drive of 10Gb or more
free. However more memory is better. As a general rule “Buy the best you can afford” and don’t forget, it is better 
to forego a little speed and have more Ram.

All PC’s will need to have a USB port available for the dongle.

FastARTIST will ONLY work with Windows XP and 2000.

USB 1.1 port (high speed 2.0 recommended)

CONTACT INFORMATION
Contact U.S. Screen Print & Inkjet Technology in the US for help or support.

Main Corporate office: +1-480-929-0640

Support Department: +1-480-929-2937

Internet Support: www.screenprinters.net Click on the Support link.

Email Support: support@usscreen.com

Support hours are 7a.m. to 8p.m Monday through Friday, 9a.m. to 3p.m. Saturday. Arizona is on Mountain
Standard Time in the US but DOES NOT change times during daylight savings. This means in the summer,
Arizona is the same time as California and is three hours earlier than the east coast of the US.

Do not be overwhelmed by the detail in this manual or all the features of the program. Keep in
mind the 80/20 principle. You will use 20% of the program 80% of the time. In fact you will find
yourself doing the same things over and over and over.

Remember, FastARTIST is a customized version of a very powerful sign and vinyl cutting
program called SignLAB. Many unnecessary routines and features of SignLAB have been
removed but many still remain for the graphics power user.

Please take time to read the complete T-Jet Manual that came with your printer BEFORE you get
too bogged down with FastARTIST. Don’t forget you MUST install the Epson driver that came 
with your T-Jet. It is found on the T-Jet Driver CD that came with the machine. You need the
Epson driver to do nozzle checks and maintenance.

Note: This manual is designed to work with FastARTIST/FastRIP for the Standard T-Jet and
FastARTIST/FastRIP for the Jumbo T-Jet. Some screen captures and pictures may be slightly
different depending on what version you are installing.
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INSTALLING FASTARTIST
FastARTIST is very easy to use. In fact if you have experience with Corel, Adobe Illustrator or Photoshop you
should have no problem using FastARTIST. It is a vector based program (like Corel and Illustrator) with many
Photoshop like bitmap controls.

Insert the FastARTIST Program CD into your CD drive. Most Windows configurations will automatically launch
the setup program. If this is not the case, double-click on My Computer and find the CD drive. Double-click on
the Setup icon to launch the installer.

Note: due to software upgrades and changes, your installation menus may or may not look exactly like the
following images.

You should always close down any Windows applications before starting an installation. DO NOT insert the
dongle until FastARTIST is installed.

You will be asked what language you want the installation to use. FastARTIST is ONLY in English although you
could choose another language for the installation prompts. The next screen will Welcome you to FastARTIST
installation. Click Next.

License
You will be asked to approve the license agreement. Check that you accept and click Next.
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Installation Folder
You will be asked to approve the installation folder. For easy use, leave the default to FastARTIST. Check Next.

You will then be asked to approve the Program Folder. Click Next.

FastRIP Basic Installation
The next screen will show that FastRIP is being installed.
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Fonts and Clip Art
You will be asked if you want to install the Fonts. Checking Continue will install all the fonts that came with
FastARTIST. You may be asked to insert the Fonts CD. If the system does not find the fonts, you can copy the
Fonts folder from the CD to your FastARTIST directory and install the fonts at a later time.

You may also be asked if you want to install the ClipART. This can take a long time and use hard disk space. If
you have a large hard disk then it will be easier to install them.

Finish Installation
When the installation is done, check that you want to restart the computer and click Finish.
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Desktop Icon
You should now have a FastARTIST desktop icon.

If not, go to the Windows Start button and then All Programs. Find the FastARTIST listing. You may also have
TWO FastARTIST listings. One says Demo. This is for people who try the program before buying it. Ignore this
listing. You can right mouse click on the FastARTIST icon and create a shortcut to your desktop.

You can double-click on this to launch FastARTIST. But first you must insert
the dongle. Please read the following.

THE FASTARTIST/FASTRIP USB PORT DONGLE
The USB Port Dongle is a sealed plug that is provided with FastARTIST as a means of preventing software
piracy. Ideally, the USB dongle should be connected to the workstation after FastARTIST has been installed.
Otherwise, there is a risk that Windows will label the dongle as an “unknown USB device,” which then requires 
extra steps to correct.

To avoid problems with Windows, connect the USB dongle AFTER FastARTIST is installed!
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If Windows has mistakenly labeled the dongle as an “unknown USB device.” The technique for correcting this 
problem is as follows:

 From the Windows Start menu, open the Control Panel.

 From the Control Panel under Windows 2000 and XP, double-click the System icon.

 From the Hardware tab, click the Device Manager button to display all of the hardware that has been
connected to this workstation.

The Device Manager window lists all of the hardware that is connected to the workstation.

1. Within the Device Manager window, locate the USB device that is identified as an unknown device,
and then choose to uninstall/delete the unknown USB device.

2. Close the Device Manager (and if necessary, click OK to close the System Properties dialog).

3. Disconnect the USB dongle.

4. Place the FastARTIST program CD into the workstation CD-ROM drive. If prompted to choose a
language, then click Cancel.

5. From the Start menu, choose the Run item.

6. From the Run dialog, click Browse and locate the file called “HINSTALL.EXE” that is on the CD.

7. After the “HINSTALL.EXE” file has been found, click within the edit field and type “ -i” (space-minus-
eye) after the filename.
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1. Click OK to close the Run dialog, and the USB dongle driver software will be reinstalled.

2. After the USB driver software has been reinstalled, reboot Windows.

3. Now that FastARTIST has been installed and Windows restarted, connect the USB dongle. The
dongle will be recognized properly and associated as a FastARTIST-related device. If there are any
further problems, then please contact Technical Support.

Do Not Lose The Dongle!
The dongle is the only way to secure the program. It is an integral part of your purchase. Think of the dongle as
hardware and treat it as such. If you lose the dongle, we cannot simply replace it without charging you for another
dongle. Guard and protect the dongle because without it, FastARTIST and FastRIP will not function. The easiest
way to protect yourself from loss or theft is to make sure the software AND the “hardware” dongle are covered by 
your insurance. A replacement Dongle can be purchased. Contact customer service for pricing.

If Dongle Does Not Work
If the Dongle ceases to operate within the 1 year warranty period it will be replaced at no charge AFTER it has
been returned to the U.S. Screen Print & Inkjet Technology. Make sure to insure the dongle for at least $750. If
the dongle is not under warranty, a replacement dongle can be purchased. Contact U.S. Screen Print for pricing or
for details on purchasing or returning a defective dongle. All returns must be shipped in a trackable carrier, insured
for $750, and have a return authorization number on the box from the U.S. Screen & Inkjet Technology.

INSTALLING AND CONFIGURING FASTRIP
FastRIP is a print controller that is the heart of the system. It controls how much ink is laid down, how many
passes are made by the printing head and how white is printed. FastRIP is a very powerful program that is part of
FastARTIST. For more detail about how to use FastRIP read the FastRIP section of Chapter 12.

When the FastARTIST installation is complete the program can be launched by double-clicking on the
FastARTIST icon. But, FastRIP has not been configured.

More about the Dongle
Very Important! The USB port dongles are sensitive to how they are plugged in.

USB Port Dongle - DO NOT plug in the dongle until AFTER you are finished with the installation. If the dongle
is plugged in prior to installation, you may accidentally let Windows install the wrong driver for the dongle. The
USB dongle can be plugged while the computer is running because USB ports are hot-pluggable.
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Note: In the event that you have a bad dongle or if the dongle driver is not installed correctly by the FastRIP
installation routine, FastRIP splash will open. If window states, “Dongle Error. Dongle not found or valid”, the 
Dongle is not recognized by the computer. Refer to Appendix A.

Computer Connection
A computer to printer connection method must be selected. There are a few ways to connect the T-Jet printer -

USB to Parallel, Parallel, USB to USB, Firewire

Parallel Cable

--Most Standard Parallel to Parallel Cables will work (IEEE1284).

USB Cables:

--Most standard USB to Parallel or USB to USB cables will work.

--USB 2.0 is recommend up to 10 feet

Firewire

--IEEE 1394 up to 10 feet long

Install Epson Drivers
Install the regular Epson Stylus Photo 2200 driver for your inkjet. The normal driver is for Head Cleanings,
Nozzle Checks, Head Alignment, and color output. Turn the Fast T-Jet printer ON.

CONFIGURING FASTRIP
From your windows desktop go to Start–Programs–FastARTIST, after clicking on FastARTIST a drop down
menu will open to the right - Click to launch FastRIP. As this is the first time FastRIP has been launched the
Configure Printers window will open asking for you to select a printer/s. Select the appropriate T-Jet version.

Note: Depending on the version of FastRIP, the image may not look exactly the same as below



Chapter 1–Getting Started and Installation

9

The second window will ask for the printer package. A printer package contains all of the custom Print Modes
that tell FastRIP how to print on garments. Your version of FastARTIST may automatically install these print
modes and printer packages.

The printer package is on the FastARTIST CD. When you get to a Select option "Search for new printer
package versions from CD” insert the FastARTIST CD in the CD Drive.  Put a check mark by Search CD-ROM
or floppy drive. Click Next. Click Next. Click Finish.
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You will then be asked to tell FastRIP the name of the USB port the printer is attached to. Select the Fast T-Jet,
Fast T-Jet2 or Fast T-Jet Jumbo printer and change the Port (the port the T-Jet printer is connected by). The USB
cable will look like Epson Stylus 2200_USB00*, Epson Stylus Pro 4800_USB00*, Epson Stylus 7600, or
Epson Stylus Pro 4800_USB00*. The LPT cable will look like LPT*.

The Output Port depends on the type of printer cable that is connected from the computer to the printer. The ports
could be USB, LPT (Parallel cable), or Firewire.

*Note--If connected by USB cable, refer to Appendix A for details on how to find the correct USB Port.Click
Finish.
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Configuring FastRIP from within FastARTIST
When in FastARTIST you can also select the File menu and then FastRIP Setup. This will bring up a different
window that will determine how your printer is connected. It will then launch FastRIP and you can do the setup
from the FastRIP Setup section of Chapter 4.

Configuring FastRIP
FastRIP should have opened after the configuration. If not, in FastARTIST go to the File menu and Launch
FastRIP. In the event that you have a bad dongle or if the dongle driver is not installed correctly by the FastRIP
installation routine, FastRIP splash will open. If window states,“Dongle Error. Dongle not found or valid”,the
Dongle is not recognized by the computer. Refer to Appendix A.

The FastRIP Program Screen or Queue
This is the same window you will see when the RIP is working. The top menu allows you to change many of the
settings of the RIP. Do not be confused by all of the options. This window also may be called the FastRIP
window or Queue window. Refer to Chapter 4–Printing CMYK for instructions on how to use FastRIP.
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Printer Driver Installation
Open the Manage Printers window. Go to Printers/Manage Printers. Make sure your T-Jet shows up under
printers and that the correct Port is showing. This is where you can troubleshoot and change ports.

Important note: If you want to be able to print DIRECTLY TO FASTRIP from programs like Corel Draw,
Illustrator, Photoshop, etc., you MUST put a check under the Control Panel menu. Click Ok. This will add
the printer to the Printers Window so that you will be able to print directly from other programs. You can
ONLY print from programs other than FastARTIST for CMYK images and not images that contain white
ink!

Consult your Fast T-Jet manual for details about printing directly to FastRIP.

Final Configuration and Preferences
You will also need to set the FastRIP Preferences and will need to Configure FastRIP in the FastRIP Setup
window. There are a number of tabs that effect how the RIP works. These are called Preferences. For additional
information on configuring FastRIP and the FastRIP Setup Preferences menu go to Chapter 12 –Printing CMYK.
Chapter 12 also details how to run and use FastRIP.

Troubleshooting FastRIP
A typical FastRIP problem is it will not find the dongle.

The error you see when the FastRIP Splash screen opens is Dongle Error. Dongle not found or valid.

Solution:

Windows XP or 2000

1. Put the FastARTIST CD in the CD Drive. Go into My Computer or your Explorer. Right click on the
drive the FastARTIST CD is in. Click Open. Go into Dongle Driver HDD32. Double click on
HDD32.exe. Click Next. Click Next again. Click Finish.

2. Go back into the contents of the FastARTIST CD. Go into Dongle Hasp Driver. Double click on
Drives.bat.

3. Open FastRIP.  If you still get the error, “Dongle Error. Dongle not found or valid” contact the Support 
Department.
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Removing FastARTIST

If for some reason FastARTIST is not operating correctly and you are asked to remove it and reinstall. Run the
uninstaller from the control panel Add / Remove programs. Make sure to remove BOTH FastARTIST and
FastRIP.

Save any artwork you have in the FastARTIST install directory into a back directory and then delete the
FastARTIST directory.
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CHAPTER 2
OVERVIEW AND WORKSPACE

PROGRAM OVERVIEW
FastARTIST is very easy to use. In fact if you have experience with Corel, Adobe Illustrator or Photoshop you
should have no problem using FastARTIST. It is a vector based program (like Corel and Illustrator) with many
Photoshop like bitmap controls.

This section will give you a quick sample of how to use the program. The next section in this manual details the
Workspace and tools in the program.

CREATING AN IMAGE IN FASTARTIST/SIGNLAB

Working with Type
To create an image in FastARTIST/SignLab simply click on the Text Tool in the Toolbar. Select the Text
Compose icon. This will bring up a blinking cursor and allow you to type in text
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Enter text onto the working page. This page size can be changed to fit the size of page/garment you are using
when printing to Fast T-Jet. If you are printing the T-Jet Jumbo you can open Templates that are preset for the
size of image and shirt bed you are using. The standard bed on the Jumbo has six shirts. You can also change the
typeface and other type attributes from the top menus Smart Bar. FastARTIST/SignLab came with hundreds of
typeface selections.

You can change the fill color of the type by first changing to the Select Tool. Make sure the type is selected by
clicking on it and that is has nodes around it (showing that it is the active object that you are going to work with).

You can then select a color from the bottom color palette and simply click on a color to change the fill, or drag a
color by holding down the mouse left cursor and dropping the color on the type.
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You can move type of any object around the page by clicking in the CENTER on the small square and dragging
the mouse/object to the new location. You can size any object or type by clicking on one of the edge or corner
nodes and again, dragging the item.

And as with other computer graphic programs, you can use the arrow keys on the keyboard to “nudge” items 
(move slightly), plus you can click-and-drag around the images to select them all and then you can Group them
(Control G) and Ungroup them (Alt G).

Adding an Outline or Stroke to Type
You can give the type an outline (also called a stroke) by clicking on the Stroke and Fill Tools icon. Select the
Line Style icon. You will see that the top menu Smart Bar has changed and you can select Hairline or Line
Thickness and change this thickness. You can also send the outline behind the fill in this menu.

Modifying Type
You can modify or Transform type by going to the Transform drop down menu and clicking on
Transformation. You will see a new top menu with many selections. You can distort, arc and do dozens of type
transformations from this menu.
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Now is your chance to explore these menus. Be bold. Just start to click and see what happens. You can add very
interesting effects called Eye Candy to simple type. Click on the Bitmap pull down menu (yes, this type is not a
bitmap but Eye Candy is a plugin that is under the Bitmap menu). Select an effect and have fun!
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Adding Clipart
FastARTIST shipped with thousands of clipart images and symbols. You can also use third party clipart images
from industry suppliers. Your Clipart CD also includes a PDF catalog of all clipart and fonts for easy reference.

To include a clipart image with your design you can either Open or Import the clipart from the Clipart folder in
the FastARTIST folder–or from any folder on the computer. You can also go to the Clipart Viewer from
Layout menu. This will bring up all the contents of the Clipart Folder (or any graphic folder of your choice) and
will let you either click on the image or drag it to the page.
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You can now color the clipart or change the outline thickness just like type. You may have to UnGroup the clipart
(alt U) or break the paths–Arrange/Break Path.

Adding Bitmaps to an Image
So far you have been working with Vector objects. These are all “math” to the computer and are high resolution 
because they print at the resolution of your printer. You can size them up and down without having an effect on
the quality. A bitmap is an image that is made up of tiny pixels. The number of pixels is called the Resolution.
The lower the resolution the more jagged the edges will be. Web pages use a resolution of 72 dpi (dots per inch).
Scanners typically default to 72dpi for the scan resolution (this can be changed). This is also often the resolution
of artwork you get from customers. You should be working with images at the final print size at resolutions of 150
to 250dpi. FastARTIST will allow you to work with bitmap images much like Photoshop. You can increase the
resolution, lighten, sharpen, manipulate and more.

To bring a bitmap image into FastARTIST (it can be a JPG, TIF, PSD, EPS and other common graphic formats)
you simply Import the image from the File menu. When you Import an image you get a small “angle” cursor. 
You can simply click to Import the image at the actual size or you can click-and-drag to size the image as you
import it. To modify a bitmap image, make sure it is selected (Select Tool) and there are nodes around it. Then,
double-click on the image to bring up the bitmap editor on the top of the menu bar.
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You can now do painting, select certain areas for additional work, or go to the Bitmap pull down menu and then
Color Adjustments and Curves to lighten or darken the image and much more. Most customer supplied artwork
needs a little lightening and a little sharpening! Be bold. Tweak their artwork before you print it!

Printing a File
Once the image is the way you like it you are ready to print to your Fast T-Jet. From the File menu click on Print
to FastRIP. The next window will let you verify and adjust the image position on the printing page (a page or
shirtboard size you already setup in FastRIP setup). If printing to the T-Jet Jumbo you can see how all the images
will print on the printing bed. Next, you simply press the small Print icon on the toolbar.
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Pressing the Printer icon starts FastRIP. FastRIP is a special printer driver designed to work with your Fast T-Jet.
It has Print Modes for various types of artwork and print speeds. FastARTIST and FastRIP are the magic when
printing to your T-Jet. You can now print dozens of the same image on your T-Jet using the colors of CMYK.

If the image is going on a dark shirt color where white ink is needed, there are additional steps covered in the
Printing With White Ink chapter. If printing to the T-Jet Jumbo you can actually mix light and dark shirts and
create underbases for dark shirts and just print the colors of CMYK on light shirts.

This has been a quick tutorial on using FastARTIST. The following section goes
into great detail about the program.
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WORKSPACE ELEMENTS
The FastARTIST - FastARTIST/SignLab workspace is arranged to simulate a working area, where the Page Size
can be set as a visual cue of the available space for the printing area.

Page Size

Garment
Size

The basic display of workspace objects may be modified from the View menu.

The View menu items are summarized as follows:

Show Page Size Show an outline that visually represents the page size.

Show
Substrate

Set the sign page size according to the substrate color, as
indicated by the currently selected Sheet Layer plate.
When the Show Substrate option becomes disabled, the
sign page color will be reset to white.

Show Fill Toggle the use of wireframes to improve the screen refresh
time.

Show Bitmap
Outlines

Display outlines in place of bitmaps in order to improve
the screen refresh time.

Link Show Fill and
Bitmap Outlines

When Show Fill is toggled, also causes wire frames to be
shown instead of bitmap image.
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Show Line
Style

Toggle the display of line styles for workspace objects.

Show Overprint
and Overlap

Toggle the display of the crosshatch and diagonal patterns
that are used to indicate that a shape will be printed with
the Overprint or Overlap property.

Show Rulers Toggle the display of workspace rulers.

Show Bitmaps Only Hide all objects that are not bitmaps.

Show Reduced
Bitmaps

For display purposes only, reduce the color depth and
resolution of bitmaps. This will improve the screen refresh
time.

Show Grid Toggle the display of grid lines.

Show Guide
Labels

Toggle the display of guideline labels.

Palettes Choose the color palettes that are visible.

Toolbars Choose the custom toolbars that are visible.

Show
InstantReplay

Show the InstantReplay window.

Show Storage
Bin

Show the Storage Bin window.

MULTIPLE DOCUMENT WINDOWS
To have more than one FastARTIST/SignLab window open at the same time, enable the Multiple Instance option
under the Options menu. To help manage these windows, there will be two additional commands under the File
menu: Close and Close All.

 Close–Close the current FastARTIST/SignLab window (prompt to save)

 Close All–Close all of the FastARTIST/SignLab windows

Having extra FastARTIST/SignLab windows allows components of the design to be edited separately and then
combined.

 To move a selected object between FastARTIST/SignLab windows, use the Copy and Paste commands.

 Objects can also be drag-and-dropped between FastARTIST/SignLab windows.

WORKSPACE COLORS
Select Options | Workspace Colors.

The Workspace Colors dialog is used to customize the basic appearance of the workspace.

 The Background Color refers to the area around the sign blank.

 The Grid Color refers to the grid lines on the workspace.

 The Guideline Color refers to the guides.

 The Page Color refers to the edge of the sign blank.

The color within the sign blank is set within the Current Selection of the Page Size dialog (Layout menu).

REFRESH SCREEN
To refresh the workspace, select Edit | Redraw.
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Page Size Area
The page size is a visual representation of the area that is available for printing and/or cutting. The Page Size
dialog is used to customize the dimensions and orientation of the page. In this fashion, the spatial arrangement of
workspace objects may be verified prior to beginning a print a job.

The Page Size dialog is accessed by choosing Page Size under the Layout menu.

If you are printing to the T-Jet Standard, you will find Page Sizes that correspond to the standard shirt holders. If
you are printing to a T-Jet Jumbo you can either choose one of the Template sizes if you want to create a single
piece of artwork that will fit within a template, or you can choose the entire printing bed size of 50” x 24” if you 
laying out custom size items. For the Jumbo, you can also simple Open a Template from the Template folder.
Templates automatically change the Page Size.

Standard T-Jet Jumbo T-Jet Jumbo T-Jet

Origin Selection
The Origin Selection is used to indicate the zero position of the page size. By default, the zero position is set to
the lower-left corner of the page.

Orientation
The Orientation refers to the rotation of the page size (i.e., the document orientation). This Orientation is
independent of the page size orientation that is used when printing.

Current Selection
The Current Selection drop-list is used to choose the size (width by height) of the page size. If the Custom size is
chosen, then the Width and Height fields may be entered.

Below the drop-list is the default color of the page size. When a new workspace is created, the page will default to
this color.
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Dimensions
The Dimensions section of the Page Size dialog displays the current dimensions of the page. If the Landscape
option is enabled, then these values will be swapped (i.e., height by width).

Advanced Settings
Click the Advanced button to toggle the display of advanced blank size controls. These controls are used to create
a blank/page size that can be added to the Current Selection drop-list.

The advanced controls have two lists of blank sizes. The top list contains blank sizes that have yet to be added to
the Current Selection drop-list. The bottom list contains blank sizes that are available in the Current Selection
drop-list.

Create and Add New Blank/Page Size
If the Create and add new blank/page size button is clicked, then the advanced blank size controls will be
temporarily replaced with controls for entering the new blank size.

After entering the Name, Width, Height, and Units for the new blank size, click the Add New Blank button. The
blank size will be added to the bottom list of blank sizes (i.e., it will be available from the Current Selection
drop-list.
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Add to List
For a selected blank size in the top list, click the Add to List button to include the blank size in the bottom list
(i.e., add the blank size to the Current Selection drop-list).

Delete
For a selected blank size in the top list, click the Delete button to remove the blank size.

Remove From List
For a selected blank size in the bottom list, click the Remove From List button to remove the blank size (i.e.,
remove it from the Current Selection drop-list). However, the blank size will remain available in the top list.

Display at Start Up
If the Display at start up option is enabled, then the Blank Size dialog will open when a new workspace is
created.

ORDER OF WORKSPACE OBJECTS
Select Arrange | Order.

Though objects are usually edited in terms of their width and height, workspace objects also have a layering order
that determines whether an object will appear to be on top of another object. The order of individual objects may
be modified using the following commands from the Arrange | Order menu.

To Front [Ctrl + F] Position the selected object before all other objects

To Back [Ctrl + B] Position the selected object behind all other objects

Forward [Ctrl + U] Increase the relative position of the object

Backward [Ctrl + L] Decrease the relative position of the object

To
Position

Enter the order or layer number of the position you
want the object placed in.

Reverse [Ctrl + M] Invert the relative order for a group of selected objects

Circle has a higher layer order than the square

Circle has a lower layer order than the square



Fast ARTIST - SignLab7.1

28

Toolbars
There are several toolbars available in FastARTIST/SignLab.

 System

 Operation

 Workspace

 Tools (including Zoom Tools)

To toggle the toolbars on or off, select View | Toolbars.

To customize the toolbars select View | Toolbars | Customize.

Custom Toolbars
The System, Operation, Workspace, and Tools toolbars are available by default. Toolbars may also be
customized by right-clicking any of the toolbars. These customize controls are also available from the Toolbars
flyout (View menu).

Customize
When a new toolbar has been created, the Customize Toolbar dialog is used to add, remove and rearrange the
available commands.

The Customize Toolbar controls are described as follows:

Available
Toolbar
Buttons

This list displays the buttons that are not currently on the Customizable
Tool Palette. To add a button to the palette, first select the button from
this list, and then click the Add button.

Add To add a button to the Customizable Tool Palette, select a button from
the Available toolbar buttons list, and then click the Add button.

Current
Toolbar
Buttons

This list displays the buttons that are currently on the Customizable Tool
Palette. To remove a button from this list, first select the button from this
list, and then click the Remove button.

Remove To remove a button from the Customizable Tool Palette, select a button
from the Current toolbar buttons list, and then click the Remove button.

Close Click the Close button to exit the Customize Toolbar dialog.

Reset The Reset button returns the Customizable Tool Palette to the settings
that were in effect when the Customize Toolbar dialog was opened.

Help Press the Help button to access the On-line Help.

Move Up To increase the priority of a button, first select that button in the Current
toolbar buttons list, and then click the Move Up button.

Move
Down

To decrease the priority of a button, first select that button in the Current
toolbar buttons list, and then click the Move Down button.
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System Toolbar

The System toolbar includes the tools for file operations.

To toggle the toolbar on or off, select View | Toolbars.

New Open a new workspace.

Blank Size Opens the Blank Size dialog where you can change the dimensions and
orientation of the sign blank.

Open Open a previously stored selection of operations.

Save To save operations for later use, select the desired operations and click
Save File.

Import Import a file into the workspace.

Export Exports the workspace, allowing you to save it in a variety of file
formats.

Undo Reverse the previous operation. When node editing, only five levels of
Undo are permitted.

Redo Reverse the previously performed Undo operation.

Close Window Closes the current FastARTIST/SignLab window.

Exit Exit FastARTIST/SignLab.

To customize the toolbar select View | Toolbars | Customize.

Operation Toolbar
 To toggle the toolbar on or off, select View | Toolbars | Operation.

 To customize the toolbar select View | Toolbars | Customize.

Workspace Toolbar

Remove All Guides

InstantReplay

Show Storage Bin

Simplify

Gradient Fills

MultiSpot Gradient Fills

Pattern Fills
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Metamorphosis

Render to Bitmap

Clipping

Clipping Clear

Contour Cut

Array

Alignment

Outline

Shadows

Transformation

Fit Text to Path

Sort Colors - By All Objects

Pan State

Percent Zoom

Print and Cut

Tools Toolbar

Select The Select tool is used to select objects.

Cut The Cut button opens Cut Preview mode, which displays workspace shapes
as they will be cut on the material.

Measure The Measure tools are used to label workspace dimensions, and to place
notes about workspace objects.

Text The Text tools are used for creating text on the workspace.

Zoom The Zoom tools are used to zoom in and out to view the sign blank.

Weld The Weld tools are used to bond overlapping shapes into a combined object.

Shape Basic shapes are available from the Shapes toolbar.

Graphics
Edit

The Graphics Edit tools are available for node, free, and arc editing.

Scan The Scan tools include AccuScan, Photo Machine, and Center Line Tracing.

Stroke
and Fill

Line Style, Gradient and Pattern Fills are available from the Stroke and Fill
toolbar

Ginsu
Knife

Open and Close Path tools are available from the Ginsu Knife toolbar.

Click on the links for more detailed information about the tools listed above.

To customize the toolbar select View | Toolbars | Customize.
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Zoom Tools
As a tip, pressing the F8 function key will return the view to the sign blank, which is equivalent to 100% zoom.

The zoom functions are summarized as follows:

Zoom In [F5] Focus on marquee drawn by cursor. Right-click
to zoom out.

Zoom Out [F6] Display more area of the workspace.

Zoom In [Shift+F6] Alternative method to focus on workspace area.

Zoom to
Selected Object

[F7] Fit the viewing area to the selected objects. If
no objects are selected, then fit to all objects.

Zoom to Blank
Size

[F8] Fit the viewing area to the sign blank.

Zoom to
Previous View

[F9] Toggle between the current and previous zoom
levels.

Pan Workspace [Middle
Button]

Click-and-hold on workspace, then drag view.

Percent Zoom [Mouse
Wheel]

View workspace at a specific zoom level.

SmartBar Controls
The SmartBar is a special toolbar in FastARTIST/SignLab that provides context-sensitive controls according to
the type of operation that is being edited. When a shape is selected, the SmartBar displays information such the
shape size and position.

If for some reason you undock or close the Smart Bar there is no “button” to push to “find” or restore the Smart 
Bar. If you do not have a Smart Bar please call technical support for help restoring it.
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Objects Selected
The shape type is listed at the far-left of the SmartBar. Next to the shape type, the number indicates the database
order of the shape. When pressing [TAB] to advance between different shapes, the [TAB] order is the same as the
database order.

Current Nub
Selecting a shape will reveal its bounding-box, which as nine square nubs that are used for moving, scaling and
resizing the shape. Within the SmartBar, the anchor controls indicate the current nub. When the SmartBar is used
to move or resize a shape, the current nub is used as the reference. For example, clicking the lower-left nub in the
SmartBar will indicate that shapes should be resized with respect to their lower-left bounding box.

Selected object Anchor controls

If the anchor nub is clicked in the SmartBar, then a small, "anchor" icon will appear within the bounding box. To
use the anchor nub, position the anchor over a specific part of the shape. Then, type new X and Y coordinates in
the SmartBar. The anchor will be moved to the new coordinates, and the shape will be moved with the anchor.

X & Y Coordinates of Mouse/Cursor
Below the Objects Selected field, the X and Y coordinates of the cursor are displayed, as well as the current units
of measurement that are being used on the workspace.

Object Coordinates
The X and Y fields display the coordinates of the selected object.



Chapter 2–Overview and Workspace

33

These coordinates may be changed by either dragging the object with the mouse, or by entering a new value in one
of the fields. If entering new data in a field, then the data will not be accepted until the [Enter] key is pressed.

Object Width and Height
The Width and Height fields display the size of the selected object.

These dimensions may be changed by either resizing the object with the mouse, or by entering a new value in one
of the fields. If entering new data in a field, then the data will not be accepted until the [Enter] key is pressed.

Object Scale
The Object Scale fields are used to resize the object as a percentage of its original dimensions.

The Object Scale arrows will resize the object in 5% increments. Alternatively, the scale may be changed by
entering a new value in one of the fields. If entering new data in a field, then the data will not be accepted until the
[Enter] key is pressed.

Aspect Ratio
When an object is either resized or scaled, the Aspect Ratio button may be maintained by activating this button:

Rotation
The Rotation field indicates the degrees through which the object will be rotated.

The Rotation arrows will rotate the object in 15 degree increments. Alternatively, the rotation may be changed by
entering a new value in the field. If entering new data in the field, then the data will not be accepted until the
[Enter] key is pressed.
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Object Color
At the far-right of the SmartBar, the fill and stroke color for the selected object is displayed. If no object is
selected, then the default fill and stroke colors are displayed.

Fill Primer
The Fill Primer indicates the primer color that has been applied to the object fill. If no object is selected, then the
Fill Primer will not be displayed.

Note: For more information see Primer Color, in the Spot Colors and Thermal Printing, Halftone Palette section.

Stroke Primer
The Stroke Primer indicates the primer color that has been applied to the object stroke. If no object is selected,
then the Stoke Primer will not be displayed.

Note: For more information see Primer Color, in the Spot Colors and Thermal Printing, Halftone Palette section.

Fill Halftone
The Fill Halftone indicates the halftone that has been applied to the object fill color. If no object is selected, then
the Fill Halftone will not be displayed.

Note: For more information about Halftones, see the Spot Colors and Thermal Printing,Halftone Palette section.
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Stroke Halftone
The Stroke Halftone indicates the halftone that has been applied to the object stroke color. If no object is
selected, then the Stroke Halftone will not be displayed.

Note: For more information about Halftones, see the Spot Colors and Thermal Printing, Halftone Palette section.

SCROLLING AND PANNING
The scroll bars along the vertical edge and along the bottom of the screen allow for viewing sections of the graphic
not currently in the viewing window.

Vertical/Horizontal Scroll Bars
Scroll Bars are used to scroll the current viewing window to view another part of the image on-screen. This is very
useful when using a zoomed-in view of the image.

Scroll Bar Arrows
Clicking on a scroll arrow causes the viewing window to move in the direction indicated by the arrow. This will
have the appearance of moving the graphic in the opposite direction a short distance. This distance is
approximately 1/10 the width or height of the view screen, depending on whether you are moving the view screen
vertically or horizontally.

Keyboard Shortcut: Press the [Control] key and the appropriate arrow key to move the view screen as a scroll arrow
was pressed.

Scroll Bar Elevators
Clicking on a Scroll Elevator causes the viewing window to move in the appropriate direction a large distance.
The distance moved is approximately equal to 1/3 the width or height of your view screen, depending on whether
you are moving your view vertically or horizontally.

Keyboard Shortcut: Press the [Control + Shift] keys, and the appropriate arrow key simultaneously to cause the view
screen to behave as if a scroll arrow was pressed.

Scroll Bar Thumb
Dragging a scroll bar thumb within the scroll bar causes the viewing window to move in the direction of the thumb
in very large movements. How far the view screen actually moves depends on how far the thumb is moved within
the scroll bars. When deciding how far to drag the scroll thumb, be aware that the ends of the scroll bar represent
the outer edges of the file on screen.

GUIDELINES
A guide is a vertical or horizontal reference that is used for placing objects. To create a guideline, right-click on
the desired ruler location. Objects will then "snap" to the location as they pass over the guideline.

Note: As many as sixty guidelines in either direction can be displayed on the screen.

Guidelines may be edited by either right-clicking the workspace, or accessing the Guides flyout (Options menu).

As an example, the following steps will create a guideline between two points:

1. Right-click the workspace to open the Edit Guides dialog.
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2. Set the guideline orientation to diagonal.

3. Choose 2 points from the drop-down list.

4. Set the coordinates for both Point 1 and Point 2.

5. Click the Add button. The resulting guideline will pass through the indicated points.

Guideline functionality is summarized as follows:

 Right-click a ruler to create a guide

 For a selected object, press [Shift] and right-click the object handles to create guides (not when
editing a parametric shape)

 To add guides when node editing, press [Shift] and right-click the node

 Open the Edit Guides dialog by right-clicking on workspace (when there are no objects selected)

 Open the Edit Guides dialog by Options | Guides | Edit Guides

 When dragging the position of a guide, press [Shift] to constrain guideline to nearest ruler
increment

 To remove a guide, press [Shift] and right-click the guide (when there are no objects selected)

ALIGN PALETTE
Holding the [Control] key while right-clicking on the workspace will display the Align Palette, which provides
tools for aligning objects with respect to the grid lines. Typically, these tools are applied to an object nub, though
they may also be used when node editing.

Set Origin Set the grid origin to selected location.

Resize grid Resize the grid increments based on the distance between the
selected location and the grid origin.

Snap to Grid
Intersection

Move the object, such that the nub is at the nearest grid
intersection.

Snap Vertically Move the object, such that the nub is at the nearest horizontal
grid line.

Snap
Horizontally

Move the object, such that the nub is at the nearest vertical
grid line.

If necessary, the origin may be reset by choosing Reset Origin from the Options menu.

Workspace Options
All the preferences settings for the FastARTIST/SignLab workspace are available from the Options menu, and
most are available under FastARTIST/SignLab Setup.
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General Preferences
The General Preferences dialog contains basic workspace settings that are generally common to all features.
Select the Options menu | FastARTIST/SignLab Setup | General Preferences to access the General
Preferences dialog.

Units
Unless otherwise specified, the Units set from the Options | FastARTIST/SignLab Setup | General
Preferences dialog, will be used throughout the FastARTIST/SignLab workspace and features. Clicking on the
workspace rulers may also be used to change the units.

Speed Units
If the Engraving module is installed, then the Speed Units are used to specify feed and plunge rates for tool
paths.

Weed Offset
The Weed Offset value is the distance that will be maintained between objects and the weed border.

HPGL Scale
Set the HPGL Scale to the desired plotter resolution. In the majority of cases, the required setting will be 1016.
However, consult the manufacturer specifications to verify the required value.

Layer Number
The Layer Number toggles the display of color plate numbers.

Speed Scroll
If Speed Scroll is active, then dragging over the workspace edges will scroll the workspace.

Off Disable speed scrolling

Object
Move

Only perform speed scrolling when dragging an object.

Full Perform speed scrolling when dragging an object, or when
dragging a marquee.
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Duplicates
When using the Duplicate command (Edit menu), the Offsets specified here will be used to place the new object
with respect to the original.

Grid Size
The grid dimensions are set in the General Preferences dialog. The Snap Angle is used when the [Control] is
held during certain operations, such as when editing line segments and corners.

Polyarc / Polygon
The Polyarc/Polygon setting indicates the type of shape that is produced by certain features, such as welds,
shadows, or outlines

Warning Dialogs
Throughout FastARTIST/SignLab, warning dialogs are used to allow a new user to consider pertinent details
before continuing with an operation. As a user becomes more proficient with a given operation, that user may
choose to disregard further warning dialog for that operation. A warning dialog may be disregarded by clicking its
Do not show this dialog box in the future option. However, if another new user begins to use
FastARTIST/SignLab, the Reset button will force all warning dialogs to be shown during operations.

Other Options and Preferences
The following sections describe other options and preferences.

Export Error Tolerance
When exporting a file from FastARTIST/SignLab, the file sometimes contains a very large number of nodes. This
is especially true of artwork that was originally imported from another software. As a solution,
FastARTIST/SignLab files can be exported using a certain tolerance level. This will make the exported artwork
smoother, as well as substantially reduce the number of required nodes.

The Error Tolerance is specified in the current workspace units. We caution against a high Error Tolerance
value, since this may introduce distortions of the exported objects. Generally, the default values (0.001 or 1/1,000
of an inch) will work very well with most files.
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Undo Setup
The Undo Setup dialog (Options menu, FastARTIST/SignLab Setup)is used to limit the resources that are used
for storing Undo operations. Limiting the resources can prevent the loss of system performance that could occur
when large quantities of image data are on the Undo stack.

See Undo and Redo for more information on the Undo operation.

Dialog Box Font Setup
The Font Settings dialog is used to specify the font type and point size that are used in FastARTIST/SignLab
dialog boxes.

Use Default Indicates that the standard Windows font should be used.

Automatic Chooses the most appropriate font to be used.

Select Enables the dialog font to be chosen.

Color Management
Monitors and printers are sometimes referred to by the quality of their gamuts, where a gamut represents the entire
range of colors that the device is capable of reproducing. Though not possible for a given device, a perfect gamut
would be all the colors that the human eye is capable of perceiving. Compared to large format printers, monitors
have a smaller gamut. Further, printers and monitors have overlapping gamuts, such that some printer colors are
not reproducible on a monitor, and vice-versa.

The Color Management dialog settings can be accessed through the Options menu, Setup flyout. These settings
indicate the input and output profiles that will be used when:

1. Using a device (i.e., a scanner) to import an image or line art

2. Using a monitor to display the artwork while editing
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3. Printing to a specific model of printer with specific media and loaded inks

When FastARTIST/SignLab is installed, the FastARTIST/SignLab 7.1 settings are used as the default profiles. For
previous FastARTIST/SignLab users, the FastARTIST/SignLab 7.0 profiles are available if needed. Alternatively,
choose Custom and click Advanced to select the specific profiles that are needed.

Despite the lack of correspondence between printer and monitor gamuts, FastARTIST/SignLab provides screen
proofing as a means of previewing screens colors as they will appear when printed. This is a Color Management
feature that attempts to reconcile the printer colors with that of the monitor (though this is not always possible).
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Selection Tool Settings
The Selection Settings determine the workspace behavior when shapes are selected and moved using the cursor.

Use live cursor
The Use live cursor will recognize when it passes over an object. Note that FastARTIST/SignLab must be
restarted for changes to this option to take effect.

Use live cursor (off) Use live cursor turned (on)

Use Filled Region to Select
By default, clicking within the filled region of a shape will cause that shape to become selected. However, this
may not be desirable where a complex workspace has multiple overlapping shapes. If the Use Filled Region to
Select option is disabled, then a shape may then only be selected by clicking the edge of that shape.

Use default snapping range
The Snapping Range determines how close a mouse click must be before it snaps to the nearest grid or line. The
default range is three pixels, though a custom range may be set.

Highlight selected objects
The Highlight selected objects option is used to draw a highlight border around selected objects. The Highlight
size field may be used to make the highlight more prominent.

Shapes that are on a Cut Only layer will be given a red highlight. For shapes that are on a Print and Cut layer,
you can select the color for the highlight. These highlights are intended as a quick visual cue to confirm the nature
of a given shape.

To enable or disable these highlights, select the Options menu | FastARTIST/SignLab Setup | Selection Tool
Settings and check or uncheck the Highlight selected objects option. Select a color from the Color Picker for the
Print and Cut layer highlights.

Speed Scrolling
If Speed Scrolling is active, then dragging off the edges of the workspace will cause the workspace to scroll.

Preview Smoothing
When a workspace object is being dragged, an image or "ghost" of the object is typically shown. In cases where
the object is extraordinarily large or complex, only the bounding box for the object will be shown.

The Preview Smoothing option may be used to modify whether bounding boxes or ghost preview are shown.
However, note that creating a ghost preview for large objects may impact the responsiveness when dragging the
object.
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Sketching Tool Settings
The Sketch Tool Settings are used with the Graphic Creation tools, as well as for editing vector graphics.

Lines pass through nodes as stated will cause the lines to pass directly through the center of a given node. Lines
pass near nodes will cause the line to pass near but not touching or over the node. Note that FastARTIST/SignLab
must be restarted for changes to take effect.

Lines pass through nodes Lines pass near nodes

Import Bitmap Setup
When importing a monochrome bitmap, the Bitmap Import Color Settings dialog will specify the Foreground
and Background colors of the bitmap. Select Options | FastARTIST/SignLab Setup | Import Bitmap Setup to
open the Bitmap Import Color Settings dialog.
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Display Units Dialog
The Unit Properties dialog specifies the units and precision that are displayed for workspace controls. Select
Options | FastARTIST/SignLab Setup | Display Units to access the Unit Properties dialog.

Automatic Saves
The Automatic Save feature (Options menu) is used to store the current workspace at preset intervals. This
protects against the loss of work due to system failure, such as Microsoft Windows generating an unrecoverable
error.

The preferred settings are to select Automatic save enabled and set the Time between saves to a reasonable
value. By doing so, the work will be saved periodically in event of a system failure.

If a system failure does occur, then restarting FastARTIST/SignLab will restore the workspace.

The amount of work recovered will depend on the Time Between Saves setting. If the time interval is too large,
then a significant amount of work could be potentially lost when a system failure occurs. However, setting a time
interval that is too small will cause FastARTIST/SignLab to frequently interrupt your work when performing
automatic saves.

Automatic Load Enabled
Automatic Load is only valid when the Automatic save enabled is checked. When active, restarting
FastARTIST/SignLab will automatically restore the last workspace that had been stored by the Automatic save
enabled option.

This feature is useful where FastARTIST/SignLab has been shut down using the File | Exit command, but the user
neglected to save the workspace.
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When prompted to save, No was clicked, and several minutes of editing were lost. However, if Automatic load
enabled is checked, then the lost work will be reloaded when FastARTIST/SignLab is restarted. At this point, the
workspace should be immediately saved to ensure that the data is not lost.

As discussed with Automatic save enabled, the amount of data recovered depends upon the Time between saves
setting.

Create Backup Files When Saving
When the Save or Save As commands are used, the backup (.BAK) file will also be created. The backup file will
have the same preface name as the workspace (.CDL) file, and it will be stored in the same directory.

Note: Back up files are a good safety measure against losing work. However, old backup files must be periodically
purged from the system, since they can potentially consume tremendous amounts of hard disk space.

Snap To Sign Blank
Selecting the Snap to Sign Blank option (Options menu) causes objects to snap to the edges of the sign blank if
placed within six pixels of it. Selected objects will snap to the sign blank at their outer edges, and at their vertical
and horizontal centers. A small check mark beside this option indicates that it is selected.

Ruler Positions
 To change the ruler positions on the workspace, select Options | Ruler Positions.

 Select View | Show Rulers to toggle the rulers on or off.

Hot Keys Summary
Hot Key Summary

The following is a summary of the hot keys that are available within FastARTIST/SignLab. These shortcuts can be
modified by choosing Customize Shortcuts from the Options menu.
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Generic Hot Keys
These Hot Keys have general application within FastARTIST/SignLab:

Nudge selected object by one pixel [Arrow key]

Nudge selected object by five pixels [Shift+arrow
key]

Change current focus to next object in sequence [Tab]

Change current focus to previous object in
sequence

[Shift+Tab]

Move/Draw/Edit/Select with horizontal and vertical
constraint

[Ctrl+Select
tool]

Alignment Hot Keys
These Hot Keys apply alignment to the currently selected objects:

Horizontally align objects along left-edge of
bounds

[Alt+1]

Horizontally center objects within bounds [Alt+2]

Horizontally align objects along right-edge of
bounds

[Alt+3]

Vertically align objects along top-edge of bounds [Alt+4]

Vertically center objects within bounds [Alt+5]

Vertically align objects along bottom-edge of
bounds

[Alt+6]

Center objects both horizontally and vertically [Alt+7]

Note: The bounds refer to the rectangular outline of each object.

File Menu Hot Keys
New workspace [Ctrl+N]

Open workspace [Ctrl+O]

Save workspace [Ctrl+S]

Print workspace objects [Ctrl+P]

Edit Menu Hot Keys

Undo last command [Ctrl+Z] or
[Alt+Bksp]

Redo last command [Ctrl+Y] or
[Ctrl+Bksp]

Repeat last command [Ctrl+R]

Cut selected object [Ctrl+X] or
[Shift+Del]

Copy selected object [Ctrl+C] or
[Ctrl+Insert]

Paste object [Ctrl+V] or
[Shift+Insert]

Delete selected object [Del]

Duplicate selected object [Ctrl+D]

Edit selected object [Ctrl+E]
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Edit font of selected text [Ctrl+I]

Select all objects on workspace [F3] or
[Ctrl+A]

Deselect all objects [Shift+F3]

Inverse the selection of objects [Alt+F3]

Refresh the workspace display [F4] or
[Alt+D]

Layout Menu Hot Keys
Activate the Alignment feature [Alt+K]

Apply the current Alignment dialog settings [Ctrl+K]

Group the selected objects [Ctrl+G]

Ungroup the selected objects [Alt+G]

Arrange Menu Hot Keys
Move the selected object to the top layer [Ctrl+F]

Move the selected object to the bottom layer [Ctrl+B]

Move the selected object up one layer [Ctrl+U]

Move the selected object down one layer [Ctrl+L]

Reverse the layer order of the selected objects [Ctrl+M]

Create a common path from the selected objects [Ctrl+H]

Reverse the common path that was applied to a
group of selected objects

[Ctrl+J]

Convert the selected text to graphic objects [Alt+B]

Simplify the selected object [Shift+F2]

Create a clipping shape from the current
selection

[Alt+C]

Remove the clipping that was created [Alt+U]

Cut Menu Hot Keys
Open the Cut Preview plotting controls [Alt+P]

View Menu Hot Keys
Toggle the display of object fills [Alt+S]

Toggle the display of bitmaps [Alt+M]

Toggle the display of the line style [Alt+N]

Toggle the display of the rulers [Alt+R]

Toggle the display of the InstantReplay window [Alt+I]

Options Menu Hot Keys
Snap to grid [Ctrl+W]

Use guides [Alt+W]
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Functions Keys
The function keys in FastARTIST/SignLab operate as follows:

Help [F1]

Disable all Shop Palette
colors except the current
target color

[F2]

Select all objects [F3]

Refresh the workspace [F4]

Activate the Zoom In tool [F5]

Zoom out [F6]

Zoom in [Shift+F6]

Zoom to selected object [F7]

Zoom to Sign Blank [F8]

Toggle between current and
previous zoom levels

[F9]

Select the menu bar [F10]

Pan workspace toward
current mouse position

[F11]
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CHAPTER 3
PRINTING TO PAPER FROM FASTARTIST

PRINTING DRAFTS AND PROOFS
In this chapter, we will explain the File | Print command, which is used to print jobs to a Windows printer driver.
Please note that the File | Print to FastRIP command is the preferred method for printing to your T-Jet printer
while the File | Print command is used to print paper proofs, signs and other printed matter that you normally
would print to an inkjet or laser printer.

Using the File | Print command requires that the destination printer has a Windows printer driver in the Windows
Control Panel. Typically, printing in this manner is reserved for desktop printers, and it relies upon Microsoft’s 
color management and the desktop printer “print driver” to control the print layout, quality, and color integrity of 
the printed image. However, please note that the File | Print can be useful for when printing a draft or proof for
FAX’ing to the customer.

The File | Print opens the Print dialog, which is used to confirm the printer settings. Clicking the OK button will
send the job, which will also preview the job if the Preview option is checked.

PRINTER TAB
Within the Printer tab are options to select the Printer, Preview, and Setup.

Printer
The current printer selected will be shown directly under the title of the Select Printer Options dialog. A list of
available printers is shown inside the Printer list box, which correspond to the drivers that have been currently set
up using the Control Panel. Click on the required printer to select it.

Note: If a printer is not displayed in the printer list, the printer driver must be loaded using the Windows Control Panel.
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Preview
When the Preview option is checked and OK is selected from the Printer tab, the Print Preview screen appears.
The objects to be printed are displayed on screen along with the default tiling lines in place. Adjust the tiles where
necessary, and select Print to begin printing. Select Cancel to abort the print job

Note: On the Preferences tab of the Print dialog, if the print mode is set to Page Size, then the preview will identify the
page size as the object to be printed. This can be disconcerting when scaling because the nubs will be arranged about
the page instead of the image. During print preview, the SmartBar is used to adjust the preview settings.

Clicking the Setup button will return to the Print dialog. In addition, information is displayed about the image
and/or tiles of the image, including:

 The position of the object relative to the edge of the page

 The size of the selected objects to be printed

 The unit of measurement of scale for relative sizing on screen

 The percentage or ratio by which to scale the objects

 The number of tile rows and columns (for reference only)
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Align Images tool

Use the Align Images tool to adjust the placement of the image upon the page, such as centering the image.

Note: If the image is larger than the sign blank area, then the align images tool will appear as shown
below.

Fit to Page tool

The Fit To Page tool will recalculate the image size, so as to maximize the image upon the page. The aspect ratio
of the image will be preserved.

Zoom tools
The only other active tools available within the Print Preview window are the Zoom tools. They function in the
same manner as upon the SignLab workspace.

Moving Objects Within the Tiles
Objects can be moved to avoid breaking up intricate work (e.g., small text) by simply dragging the objects up or
down with the cursor. However, there is a maximum tile size based on the paper size used by the printer. If the
paper size is exceeded, a new tile automatically appears where required.
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Scaling the Objects to be Printed
The objects in the Preview screen can be scaled up or down in size to adjust the number of tiles required to print
the entire image. To resize the objects:

1. Pass the cursor over one of the corner nubs

2. When the cursor changes to a bi-directional arrow, click and drag the nub to either enlarge or
reduce the size of the objects

When objects are resized in this manner, then all of the tiles are re-activated.

Activating and De-Activating Tiles
Once the objects have been positioned, any of the resulting tiles may be printed. Only activated tiles are printed.
Tiles that are de-activated are set to gray, though a blue outline will remain to signify the inactive tile boundaries.
Clicking within the tile boundary re-activates the tile.
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About activating tiles:

 Overlapping sections are displayed, but cannot be selected.

 Right-clicking within a tile will display the outer region of the tile.

Setup
From the Printer tab on the Print dialog, clicking the Setup button will open the Properties dialog for the
selected printer. The layout of the Properties dialog will depend upon the version of Microsoft Windows being
used.

Changes made to the Properties dialog, as well as all controls that are accessed though the Properties dialog, are
system-wide. All changes will be applied to the Windows Print Driver for the selected printer. Therefore, changes
made here will be in effect for other Windows applications.

PREFERENCES TAB
Within the Preferences tab are various options, including selecting the number of Copies, as well as the option to
Fit to Printer.
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Copies
This entry box is used to specify the number of copies to be printed. This box is edited by sweep-selecting the
entry and typing in a new number. By default, the entry in this box is “1”.

Print As Shown On Screen
Enabling this option causes shapes or images to be printed as they appear on the workspace. For example:

 If the Show Fill option (View menu) is turned off, then workspace shapes will be printed as wire
frames (no fills)

 If the Show Line Style option (View menu) is turned off, then shapes will be printed without thick
lines or strokes

Printing Mode
Specify the images to be printed according to the following options:

Selected
Objects
Only

Print only those objects that are currently selected.

Sign Blank
Area

Print everything that is within the confines of the sign blank.
Any objects outside the sign blank are not printed. Note that
objects that are partially on the sign blank will be printed
accordingly.

Entire Area Print everything within the open workspace, which comprises
all objects both inside and outside the confines of the sign
blank.
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Include Bitmaps
Select this option to print bitmap files from SignLab (i.e., *.BMP, *.PCX, or *.TIF files).

Include Dimensions and Notes
This option prints any dimensions created in the file. Dimensions include any size notations or notes generated
using the Dimension tools from the Measure Tools in the tool bar.

Include Guidelines
With this option selected any Guides placed on screen will be printed along with the Guide Labels. The Guides
must be set as visible in order to be printed.

Include Grid Lines
With this option selected, the Grid placed on the screen will be printed. The Grid must be set as visible in order to
be printed, and will be printed as set to view (i.e., the Show Grid as Lines option).

Separate Colors
Enabling this option will cause each color in the design to print as a separate print job.

Clip Separated Colors
This option clips the separate colors when cutting.

Fit to Printer
For the currently loaded printer sheet, this option will adjust the image to fill the sheet.

Use TrueType Hinting
TrueType Hinting is a font technology that allows small text sizes to be legible on low resolution devices. In
addition, TrueType Hinting improves the results from scaling and rotating the text.

Avoid Printing Weed Border
Check the Do Not Print Weed Border option to prevent the weed border from being printed.

Anti-Aliasing
Anti-Aliasing is the smoothing of the jagged, "stair stepping" appearance that can appear in low-resolution drafts.
Anti-aliasing is achieved by blurring the color of adjoining pixels to improve the transition between light and dark
pixels.

The available Anti-Aliasing options are None, Coarse, Medium, and Fine. A setting of Fine will produce the
highest quality smoothing, though this will incur slower printing.

Note: Anti-Aliasing should be used for dye-sublimation printing only–NOT wax, resin, or wax/resin.

PAGE SETUP TAB
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Margins
Some printer drivers do not account for the non-printable areas, or margins of the page. In those cases, SignLab
provides for the margin settings, by accessing the Margins tab. Enter margin specifications in the entry boxes in
this dialog box as required.

Overlap
The Overlap options permit establishing settings for tiling large printed images. If the file to be printed is too large
for the printable area, use the Overlap options to set the Horizontal and Vertical Overlaps.

Horizontal and Vertical Overlap
These options specify the amount of overprint each tile will contain. Each tile actually ends with the beginning
portion of the next tile. For example, if an overlap of a half-inch is set the last half-inch of a given tile will be
identical to the first half inch of the proceeding tile. This function is useful for particularly intricate graphics, as it
provides a guide for laying the pieces of the printed file together. Each of the Horizontal and Vertical options can
be set individually.

Units
The Units of measurement are displayed for reference only, the unit of measurement cannot be changed from the
Print window. See Options | SignLab Setup | Display Units to change the units of measurement.


